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1. Before You Start 

SCO Lettings is an application called BookingPro supplied by Tucasi Ltd.  The application will be 

referred to as BookingPro throughout this document. 

We recommend that you read through these instructions carefully before attempting to install 

BookingPro. 

 

2. System Pre-requisites 

This section describes the system requirements for installing BookingPro.  If you have any questions 

about this, you may need to refer to your IT Support organisation. 

The computers on which you install BookingPro should meet the following system requirements: 

Processor 

Minimum recommended: 1.3 GHz processor 

RAM 

Windows 7 – Minimum recommended: 2 GB 

Windows 8 – Minimum recommended: 2GB 

 

Operating System 

Windows 7 Professional SP1 32bit and 64bit 

Windows 8 / 8.1 Professional 64bit 

Windows Server 2008 SP2 32bit  

Windows Server 2008 R2 SP1 64bit 

Windows Server 20012 R2 

Available Hard Disk Space 

250 MB including the .NET framework 3.5 

Other Applications 

Microsoft Office is needed to generate booking confirmations, invoices, credit notes and 

spreadsheets.  Microsoft Office versions 2007, 2010 and 2013 are currently supported. 

Database 

The computer used to hold the database must satisfy the minimum requirements for running 

Microsoft SQL Server.  For further information, refer to www.communitylettings.com/faqs.  

  

  

http://www.communitylettings.com/faqs
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3. Installing BookingPro 

This section describes how to install BookingPro in a networked environment.  Installing BookingPro 

is a straightforward process although you may need to refer to your IT Support organisation if you 

have any questions about your computer hardware or your network. 

 

BookingPro Architecture 

BookingPro is designed to be used in a networked environment. It allows multiple users on their 

individual PCs to concurrently access a single BookingPro database.  To enable this, the BookingPro 

database must be installed on a computer and a location on the network that is accessible by all 

BookingPro users. This computer will be the BookingPro server. 

The advantages of this are that it makes it easy to: 

• Update the software, ensuring each user is using the same version. 

• Incorporate the software files in a regular backup regime. 

• Configure BookingPro on additional PCs. 

 

3.1. Backing up BookingPro data 

Backing up your data is an essential part of using BookingPro and failure to do this could result in the 

loss of data.  You should always discuss backing up BookingPro with your IT Support organisation - to 

ensure that both the BookingPro software and database are secure, your IT Support organisation 

should incorporate BookingPro into their regular procedure to backup to external media.   

In addition, BookingPro contains its own backup and restore procedure which you can use to create 

backups and to restore them whenever you need to. You will be prompted to create a backup every 

time you exit BookingPro.  In addition, you can create a backup at any time using the Backup 

Database option on the File menu.  

For more details on the BookingPro Backup procedure, see the section 5 on Creating Backups. 

 

 

3.2. Installing BookingPro on the Server 

 

 

 

 

 

 

  

If you are installing on Windows Server 2008 please refer to section 0 

 

Appendix A – Installing BookingPro on Windows Server 2008. 

 If you are installing on Windows Server 2012 please refer to section 0 

 

Appendix B – Installing BookingPro on Windows Server 2012. 
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3.2.1. Install Microsoft .Net Framework 3.5 

You must install BookingPro on the server before configuring on any client PCs.   

• Log on to the server with local Administrator rights. 

• Click on the setup folder download link as per your installation email. 

• If Microsoft .Net Framework 3.5 is not already installed on the server, you will be informed 

before BookingPro is installed. 

• Press any key to continue.  Microsoft .NET Framework 3.5 will start installing.  Installation can 

take several minutes, and it is important not to interrupt or cancel it. 

 

 

3.2.2. Install BookingPro 

 

• Click on the BookingPro set up file. 

 

• The BookingPro Setup Wizard should start automatically.   
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• Click on Next. 

• Select Both the application and database software. 

 

 

• Click on Next. 

• If SQL Server Express 2008 is not installed, the following screen will be displayed: 
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• Click on Next. 

 

• Click on Yes when the BookingPro Setup Wizard pop up window appears. 

• The following screens will appear in turn. 
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• If the Setup Wizard does not display automatically, click on the BookingPro icon on your 

desktop. 

 

• The Setup Wizard will be displayed. 
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• Click on Next. 

 

• Select the required installation path. 

• Click on Next. 
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• Click on Next. 
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• Click on Close. 

 

• Click on Next. 
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• Select Create a new database. 

• Click on Next. 

 

• Select Application Default. 

• Click on Next. 
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3.3. Configuring BookingPro on client PCs 

BookingPro runs on the client PCs via a shortcut to the application installed on the server.  The only 

software required to be installed on the client PC is Microsoft .Net Framework 3.5. 

 

3.3.1. Install Microsoft .Net Framework 3.5 

• Log on to the server with local Administrator rights.  

• Click on the setup folder download link as per your installation email. 

• If Microsoft .Net Framework 3.5 is not already installed on the server, you will be informed 

before BookingPro is installed.  

• Press any key to continue.  Microsoft .NET Framework 3.5 will start installing.  Installation can 

take several minutes, and it is important not to interrupt or cancel it. 

 

3.3.2. Setting Windows access rights on server 

If you use Windows access rights control in your network, you must set the appropriate Windows 

user access rights on the server.   

• On the server machine, load My Computer. 

• Navigate to the server folder where BookingPro is installed e.g. D:\applications. 

• Right-click on the BookingPro installation folder. 

• Select Sharing and Security (or Properties) and then select the Security tab. 

• Click on the Add button (you may need to click the Edit button first) and enter the required 

Windows group name or user names. 

• Click on Check Names and click on Done.  

• Select the required Windows group/users.  Tick the Modify box below. 

• Click OK. 

 

3.3.3. Setting Windows access rights on a new Share 

If you have created a new Share for BookingPro, you must set Windows user access rights 

appropriately on the Share. You must ensure that the Share is not Read only and that the users have 

the appropriate permissions set to access the Share.  

• On the server machine, load My Computer. 

• Navigate to the folder you have shared.  For example, you may have created a new folder named 

BookingPro and shared it. 

• Right-click on the folder you have shared. 
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• Select Sharing and Security and then select the Sharing tab. 

 

 

 

• Enter the required Windows user group or user names.  

• Tick Change or Full Control (if Full Control allowed). 

• Click on OK. 

 

 

• Click Permissions. On Windows 

Server 2008 click on Share. 

 

• Enter the required Windows user 

group or user names.  
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3.3.4. Create a shortcut to BookingPro on the server machine 

• Open My Computer and browse to the folder containing the BookingPro program. 

• Right click the Bookingpro.exe icon and select Send to and Desktop (create shortcut). 

• Go to the PC desktop.  (If you want to rename the shortcut, right click the shortcut and select 

Rename. Type the new name (BookingPro) and press Enter.) 

 

3.4. Additional Configuration  

There may be additional configuration required on the server to allow the Clients to connect to the 

SQL instance of BookingPro.   

3.4.1. Enable Named Pipes Protocols in SQL Server Configuration Manager 

 

• Go to Start, select All Programs and select Microsoft SQL Server. 

• Select Configuration Tools and SQL Server Configuration Manager. 

 

NB: the screen below may differ slightly depending on SQL version. 

 

 

3.4.2. Disabling (or allowing exceptions) to your Firewall 

In addition, if you are using a Windows firewall, you may need to disable it.  If this isn’t feasible then 

the following must be added to the exceptions list through the firewall: 

sqlservr.exe 

sqlbrowser.exe  

 

• This can be done from your Windows Control Panel, from the System and Security group, select 

Windows Firewall. 
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• Click on Allow a Program or Feature through the Firewall. 

NB: the screen below may differ depending on OS. 

 

 

 

 

• Click on the Allow another Program button. 
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3.5. Start using BookingPro 

• Double click the BookingPro icon on the desktop. 

• The first time you use BookingPro, the software automatically checks to see if there are any 

updates available.  Click Next to start downloading the updates.  When the downloads are 

complete, click Finish. 

• BookingPro opens at the Welcome page.  To sign-in to BookingPro, see the section on Log on to 

BookingPro, p.16. 

 

4. Setting up BookingPro 

Before you start to use BookingPro, we recommend the following:  

• Make a list of your standard prices and the facilities you have available for hire.  

• Group the facilities together in a logical way (e.g. classrooms, pitches, tennis courts).  Creating 

groups of facilities means that they appear together in the facility list and is particularly useful 

when you want to allow the system to automatically allocate the first available facility from the 

group.  

• Make a list of the dates when the facilities are closed or when you charge higher rates (e.g. 

public holidays).  

 

4.1. Log on to BookingPro  

• Double-click the desktop icon to open BookingPro and display the Welcome screen.  

• Enter the User Name and Password you set up during the installation process. 

• Click Sign-In.  BookingPro will open with the Booking Calendar displayed. 

 

4.2. Activate BookingPro 

Before starting to use BookingPro, you should activate the software by entering your licence key 

details. 

• Click the Help menu and select Activate Product. 

• Click Next. 

• Enter your 16-digit activation code and click Next. 

• Enter your school name and click Next. 

• Click Finish. 
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4.3. Set up Users 

You can specify which users have access to BookingPro, and restrict those users to certain areas of 

BookingPro (e.g. the Calendar, Hirers, Facilities, etc.).  

• Select the Tools menu and Security. 

• Click Add to display the User Properties form. 

 

• Complete the form as follows: 

o User Name: enter the name you wish the User to sign on with. 

o Click Change Password and enter the User’s password.  Retype the new password to 

confirm and select Change Password. 

o Permissions: use the list to Allow or Deny the User access to the different areas of 

BookingPro.  (For example, to grant a User read-only access to accounting functions, 

select Accounts and check the Deny box.) 

o Allow direct access using external programs (e.g. Microsoft Excel): check this option to 

allow the User to access the database using external programs (e.g. to use the Import 

External Data option in Microsoft Excel).  

• Click OK and confirm that you wish to save the changes. 

 

4.4. The Setup Checklist 

When you log on to BookingPro, the Setup Checklist is displayed.  This helps you carry out the initial 

setup and is also a shortcut for help on all aspects of BookingPro.  This checklist can be displayed at 

any time by selecting the View menu and Setup Checklist.  
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There are four steps shown in the Setup Checklist: Configure options, Enter prices, Setup facilities 

for hire, Start entering bookings.  Clicking any of the buttons guides you to the appropriate area of 

BookingPro, while clicking the word More to the right of each step displays related Help topics. 

 

4.5. Configure BookingPro defaults 

The Options Wizard will help you configure BookingPro ready for use.  

• Select the Tools menu and select Options.   

• Click Next. 

• In the Bookings Defaults window: 

o Select Provisional or Confirmed to make new bookings default to the corresponding 

status.  

o Set the default Start time for new bookings to the time you generally start accepting 

bookings from.  

o Set the Duration of new bookings to the duration of a typical booking.  

  

 

• When you have finished making changes, click Next. 

• In the Invoicing Defaults window: 

o Set After how many days does an invoice become overdue? to the required number of 

days.  After this period an invoice is automatically marked as Overdue.  Using a value of 

zero will result in invoices not being marked as overdue.  

o Under At what number do you want to start numbing invoices? enter the required 

number. 

o Select whether or not accounting items such as invoices, credit notes and receipts can 

be changed.  
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o For printed invoices to list each booking covered by the invoice, select the Print 

Bookings option. Alternatively, for a summary of the bookings on each invoice, select 

Print Summary.  

  

•  When you have finished making changes, click Next. 

• In the Pricing Defaults window: 

o If you offer insurance cover at an extra charge, enter the charge as a percentage of the 

net cost of the booking.  When a Hirer elects to use your insurance, a charge will be 

added to any automatically generated invoices. 

o If you charge the first few hours of each booking at a different rate to subsequent hours, 

enter the number of hours charged at the initial rate. 

  

• When you have finished making changes, click Next. 

• In the VAT Rates window: 

o Add a new VAT rate by typing a name for the band in the next available row.  

o Delete a VAT rate by clicking on the row marker to highlight the row and pressing Delete 

on your keyboard.  
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o Make one of the VAT rates the default rate by highlighting the row and clicking Set As 

Default.  

  

When you have finished making changes, click Finish and Yes. 

4.6. Amend the BookingPro Templates 

BookingPro includes templates to enable you to quickly create the following: 

Microsoft Word documents: 

• Booking confirmation template 

• Hirer mail merge template to create letters to hirers 

• Insurance reminder template 

• Invoice/Credit template 

• Receipt template 

• Reminder template 

• Statement template 

Excel spreadsheets: 

• Daily booking calendar 

• Weekly booking calendar 

• Monthly booking calendar 

The Microsoft Word templates should be amended to fit on your letter headed paper and to include 

the school name, address, etc.  We recommend you read the full template to ensure the text is 

appropriate to your school. 

To amend the templates: 

• Select the File menu and select Open.   

• Select the template you wish to change and click Open. The template will open in Microsoft 

Word / Excel.  

• Make the required changes in Word / Excel. 

• Save the template and close Word / Excel. 
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5. Creating Backups 

To make it easy for you to restore data if you make a mistake when entering data, BookingPro 

contains its own backup and restore procedure which you can use to create backups and to restore 

them whenever you need to. You will be prompted to create a backup every time you exit 

BookingPro (though this can be turned off).   

In addition, you can create a backup at any time using the Backup Database option on the File menu.  

The following form is displayed. 

 

 Backup files are stored in the folder specified in the Back up database to box.  By default this will be 

a folder called Backups within your program folder (e.g. C:\Program 

Files\Tucasi\BookingPro\Backups).  If this is not the folder you wish to use for your backup files click 

Browse and select the required folder.  

By default, backup files are retained for 14 days.  If you wish to retain them for a longer period, 

change the required number of days in the Retain back up files for box. 

Normally you will be asked to backup the database every time you exit BookingPro. If you prefer this 

not to happen, uncheck Prompt me to Back Up on exit.  

Click the Back Up Now button to backup the database. Alternatively clicking the Don't Back Up 

button will close the form without creating a backup.  

 

6. Training options 

You may wish to receive training for BookingPro. 

For details of our training options, please contact us on 0844 800 4017, opt 2 
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7. Appendix A – Installing BookingPro on Windows Server 2008 

 

You must install BookingPro on the server before configuring any client PCs.   

• Log on to the server with local Administrator rights.  

• Click on the setup folder download link as per your installation email. 

• Click on the BookingPro set up file. 

 

• The BookingPro Setup Wizard should start automatically.   

 

• Click on Next. 

• Select Both the application and database software. 
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• Click on Next. 

• If SQL Server Express 2008 is not installed, the following screen will be displayed: 

• Click on Next. 

 

• Click on Next. 

 

• Click on Yes when the BookingPro Setup Wizard pop up window appears. 

• The following screens will appear in turn. 
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• The following screen will then be displayed. 
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• The installation should now be completed successfully, click OK. 

• Click on Close. 

• Next, click on the BookingPro icon on your desktop.  

• The Setup Wizard will be displayed. 

 

 

• Click on Next. 
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• Click on Next. 

 

• Click on Next. 
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• Click on Close. 

• The following screen will be displayed. 

 

• Click on OK. 
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• Click on Close. 

• Click on Accept when the End User Licence Agreement displays. 

• Open BookingPro.  A short cut should now be displayed on your desktop. 

 

• Click on No when it asks you if you want to check for any updates. 

• The Database Settings Wizard will now open. 
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• Click on Next. 

 

• Select Create a new database. 

• Click on Next. 

 

• Select Application Default. 

• Click on Next. 
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• Set a username and password.  Also enter your organisation name. 

• Click on Next. 

 

• Click on Yes. 
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• Click on Finish. 

• You will be asked to save the new settings, click on Yes. 

• BookingPro will now be installed on the server. 

 

You now need to go back to the following sections: 

 

• Please refer to section 3.3, Configuring BookingPro on client PCs. 

• Please refer to section 4, Setting up BookingPro. 
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8. Appendix B – Installing BookingPro on Windows Server 2012 

 

You must install BookingPro on the server before configuring any client PCs.   

• Log on to the server with local Administrator rights.  

• Click on the setup folder download link as per your installation email. 

• Click on the BookingPro set up file. 

 

• The BookingPro Setup Wizard should start automatically.   

 

• Click on Next. 

• Select Both the application and database software. 
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• Click on Next. 

• If SQL Server Express 2008 is not installed, the following screen will be displayed: 

 

• Click on Next. 

 

• Click on Yes when the BookingPro Setup Wizard pop up window appears. 
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• The following screens will appear in turn. 

 

 



 

SCO Lettings (v4.3) Installation Guide 35 November 2014 v2 

 

 

• The installation should now be completed successfully, click OK. 

• Click on Close. 

• Next, click on the BookingPro icon on your desktop. 

• The Setup Wizard will be displayed. 
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• Click on Next. 

• Select the required installation path. 

 

• Click on Next. 
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• Click on Next. 

 

 

• Click on Next. 
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• Click on Close. 

 

• If the above is still displayed click on Close. 

• Open BookingPro.  A shortcut should now be displayed on your desktop. 
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• Click on Accept. 

 

• Click on No when it asks you if you want to check for any updates. 

• The Database Settings Wizard will now open. 
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• Click on Next. 

 

• Select Create a new database. 

• Click on Next. 

 

• Select Application Default. 

• Click on Next. 
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• Set a username and password.  Also enter your organisation name. 

• Click on Next. 

 

• Click on Yes. 
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• Click on Finish. 

• You will be asked to save the new settings, click on Yes. 

• BookingPro will now be installed on the server. 

 

You now need to go back to the following sections – 

 

• Please refer to section 3.3, Configuring BookingPro on client PCs. 

• Please refer to section 4, Setting up BookingPro. 

 

 

9. Support 

You may need to contact your IT support organisation for assistance if you encounter any system-

related problems, for example with your network or with access rights, or if you are unsure about 

your network configuration. 

If you have any other queries when installing the BookingPro software please contact: 

Tucasi Customer Support 

Email: support@tucasi.com 

 02380 016 564 
 

10. Troubleshooting 

How can I stop Windows displaying an "Open File - Security Warning" stating that the "Publisher 

could not be verified"?  

To prevent this message being displayed every time you run BookingPro open Internet Options in 

the Control Panel, select the Security tab, Local Intranet and click Sites followed by Advanced. You 

can then add the URL of the server you are using for the BookingPro application software (e.g. 

\\MyServer).  

 

mailto:support@tucasi.com

